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Introduction

What is the T-16 Temperature Smart Sensor?

The AquiStar® TempHionTM Smart Sensor is a submersible pH/temperature sensor and
datalogger combined in one small diameter unit. The TempHionTM Smart Sensor records
over 65,000 records of ph, temperature, and time, operates on low power, and features
easy-to-use software with powerful features.

The T-16 measures temperature using low-cost, highly accurate thermistors. Up to 16
thermistors can be attached to any one T-16 recording unit.

The T-16 Smart Sensor is powered with two AA alkaline batteries or with an auxiliary
power supply for data intensive applications. The unit is programmed using a laptop or
desktop Windows® based computer via its RS485/RS232 adaptor and INW’s Aqua4Plus
software. Once programmed, the unit will measure and collect data on a variety of time
intervals.

Several T-16’s, or a combination of T-16’s, TempHions, and PT2X Pressure/Temperature
Smart Sensors, can be networked together and controlled from one location, either
directly from a single computer or via a WaveDataTM Wireless Data Collection System.

The internal processor in the T-16 Smart Sensor allows for easy calibration, using the
calibration utilities in Aqua4Plus. Once calibrated, this calibration data is stored in non-
volatile memory within the Smart Sensor. When data is collected, this calibration
information, along with sensor specific calibration information, is applied to the data,
resulting in highly accurate readings at a wide range of temperatures.

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage.  After
opening the carton, look for concealed damage, such as a cut cable. If damage is found,
immediately file a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.

Don’t install the device such that the box or any of its connectors are submerged.
Don’t support the device with the connector or with the connectors of an extension

cable.
Don’t bang or drop the device on hard objects.
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Installation and Operation

Installing the T-16

Prior to shipping your T-16, INW engineers will work with you to determine the best
configuration for your application. Depending on your particular application, the T-16
may or may not come with the thermistors connected. If thermistors are not connected,
see Appendix A for wiring information. INW will provide documentation specific to your
configuration.

Connecting External Power

The T-16 comes with two AA internal batteries. If auxiliary power is desired, you can use
a 6 - 13 VDC supply that can provide 15 mA. See wiring information later in this manual.

Connecting the T-16 to a Computer

The T-16 comes with a weatherproof 5-pin connector. This can be connected to your PC
or laptop serial port using the interface cable and RS232/RS485 adaptor, as shown in
Figure 1. For USB connections, see Appendix B.

Figure 1: Connecting the Sensor to a Computer

Installing the Aqua4Plus Software

What is Aqua4Plus?

Aqua4Plus is INW’s easy-to-use Windows-based software for communicating with and
controlling INW’s state-of-the-art Smart Sensors.

Aqua4Plus is designed as a multi-layered control program. The program can control a
number of separate sensors, via cable, radio, modem, or some combination of the three.
Aqua4Plus communicates with INW Smart Sensor using the industry standard
Modbus® communication protocol.

PC or Laptop
Computer

RS485/RS232
Adapter

Communication
Cable

Weatherproof 5-pin
Connectors

Serial
Port

T-16

Wire Seal
Thermistor

Input



5

Smart Sensors collect and store data in “sessions.” A session is a preprogrammed series
of steps describing the number of samples to record and the intervals at which samples
are taken. The Aqua4Plus software is used to create and store the sessions to the
sensors and to upload, view and export the collected data.

System Requirements

• Desktop or  laptop computer, running Windows 98 or higher.

• 64 MB RAM

• 10 MB free hard drive space

• CDROM drive (Floppy version available on request.)

• 9-pin serial port (See Application Note usb_serial-9C0153.pdf for USB alterna-
tives. This application note is supplied on the enclosed CD.)

• 56K V.92 modem - if using a modem version of Aqua4Plus

Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to
step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

Once the software has successfully completed installation, you can remove the CD from
your CDROM drive and store it in a safe place.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during installation (typically this will be Aqua4Plus), and then click the

Aqua4Plus  icon.

Refer to the Aqua4Plus software manual for in-depth details on using Aqua4Plus.
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Selecting Channels and Assigning Channel Labels

Selecting Channels
Each T-16 sensor can read up to 16 thermistors. By default, the software uses all 16
channels, whether or not there are thermistors connected to all 16. If INW configures
your system, all unused channels will be turned off. If you are configuring your own
system, or if you want to change the configuration of your current system, use the
Advanced Calibration option to select which channels you want to be active.

There are two advantages to turning off unused channels. First, all displays and output
files will show only those you have turned on, thus eliminating extraneous data.
Second, the fewer channels that are active, the more records can be stored on the
sensor.

The Advanced Calibration option is only available if there are no sessions stored on the
sensor.  If there are any sessions stored on the sensor, upload any data you want and
then erase the sessions before continuing. (Sessions Menu | Erase All Sessions)

On the sensor map, select the desired sensor. Next, select Advanced from the Configura-
tion Menu, and then select Advanced Calibration. You will be asked for a password. The
default password is admin. (This can be changed from Options Menu | Change Pass-
word.) The Advanced Calibration window will appear (Figure 2).

On the left there is a list of all possible channels. Click to checkmark those channels that
you are using, and then click OK. (If you need to change any of the calibration data or
thermistor information, contact INW for further instructions.)

Assigning Channel Labels
Each channel on a T-16 has a unique label. By default, these labels are A1, B1, A2, B2,
etc., corresponding to the channels on the board itself.  These labels display on the Real
Time Monitor as well as the data and graph displays. To assign more meaningful names
to each active channel,  use the Field Calibration option from the Configure menu.

The Field Calibration option is only available if there are no sessions stored on the
sensor.  If there are any sessions stored on the sensor, upload any data you want and
then erase the sessions before continuing. (Sessions Menu | Erase All Sessions)

On the sensor map, select the desired sensor, and then open the Field Calibration
window (Figure 3). Click on each channel you want to label. Type in a name in the
Channel Label field. When you finish changing the labels, click on OK.
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Figure 2: Advanced Calibration Window - Selecting Channels

Figure 3: Field Calibration Window - Labeling Channels
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Calibration

Before leaving the factory, each T-16 circuit is precisely calibrated to match the range of
thermistors that your application will be using. Each individual channel can be further
calibrated, if needed, using the Field Calibration option.

Calibration can only be done when there are no sessions stored on the sensor. If there
are any sessions stored on the sensor, upload any data you want and then erase the
sessions before continuing. (Sessions Menu | Erase All Sessions)

To do this calibration you will need the thermistor, an accurate temperature reference,
such as a digital thermometer, and an environment where the temperature can be
changed and stablized or two different environments with two different temperatures.

Step-by-Step Calibration Procedure (Letters in parentheses refer to Figure 4.)

1 On the sensor map, select the sensor you want to calibrate.
2. From the Options Menu, select the units you want to use, i.e., degrees C, degrees

F, or degrees K.
3. From the Configure Window, select Field Calibration.
4 Click on the thermistor to calibrate. (A)
5. Compute First Calibration Point:

a. Enter 1 in the “m” field and 0 in the “b” field. (B)
b. Place your thermistor in a stable environment, along with another accurate

temperature instrument. Allow time to stablize - this will vary depending on
what your thermistor is housed in and what temperature instrument you are
using as a reference.

c. Take a reading with your alternate temperature reference. Record this reading
in the First Point field. (C)

d. Click the Measure button. (D)
e. A measurement box will pop up showing the temperature. (Fig. 5)
f. When readings have stablized to your satisfaction, click the OK button in the

popup box.
6. Compute Second Calibration Point:

a. Change the temperature of your test environment or move the thermistor and
reference instrument to an environment with a different temperature. Wait for
stabilization.

b. Take a reading with your alternate temperature reference. Record this reading
in the Second Point field. (E)

c. Click the Measure button. (F)
d. When readings have stablized to your satisfaction, click the OK button in the

popup box.
7. Apply Calibration Values:

a. Observe the computed values to the right (G). If satisfied, click Apply button
(H) to transfer to the calibration fields (B).

b. Click the OK button (I) to save calibration values to the sensor.
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Figure 4: Field Calibration

Figure 5: Popup Measurement Window
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Collecting Data

Following is a brief overview on using Aqua4Plus to collect data. Please refer to the
Aqua4Plus Instruction Manual for further details on configuring and using Aqua4Plus.

Real Time Monitor

Figure 6: Real Time Monitor

Setting up a Data Recording Session

Click the  tool button. A Session Profile Window will open. Refer to the Aqua4Plus
Instruction Manual for details in describing your session profile. Click the Start button
to save the session to the sensor and begin recording.

Figure 7: Session Profile Window

Click Single to get  a single
reading.

Click Start to get several
readings in a row.

Click Stop to stop the reading.

Note: These are snapshot
readings and are not recorded
on the sensor.
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• Click on the session you want to upload.

• Click the   tool button.

• Select a file location.

• Select a file type (see manual for details).

• Click Save.

• Click Start.

Figure 8: Session to Upload

Retrieving Data from the Sensor/Datalogger

Viewing Data

• Click the   tool button to view data as a table.

• Click the   tool button to view data as a graph.

• Navigate to the desired file, then click the Open button. (If the File Open box does
not appear, click the File Menu, then select Open.)

Figure 9: File Display Window
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Figure 10: Graph Window

Exporting Data to .csv or .xls Files

• Using the File Display window, open the file you want to export.

• Click on the   tool button.

• Select a file location and enter a name for the file.

• Select a file type (see manual for details).

• Click Save.

A Word About  Units

Temperature readings can be displayed in degrees Celsius, Fahrenheit, or Kelvin.
 Select the units you want to use from the Options Menu, item Units.
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Appendix A: Technical Specifications

Wiring Information

Prior to shipping your T-16, INW engineers will work with you to determine the best
thermistors to use in your particular application. Based on which thermistors will be
used, INW will install specific reference resistors and calibrate the board to those
resistors.  Each T-16 can have two different reference resistors – one for the A block of
connectors and one for the B block of connectors. Eight individual thermistors can be
connected to each block. INW will provide documentation specific to your particular
configuration.

For thermistors connected to the A block, one lead connects to a terminal on one of the
COM A connectors. The other lead connects to one of the numbered A block terminals,
i.e., A1, A2, A3, etc. Thermistors on the B block are connected in the same manner on
the COM B connectors and the B block of terminals.  A wire seal is provided to bring
the thermistor lead though the side of the box. A 5-pin external connector is provided
for connecting to a PC or laptop using INW’s communication cable.

Figure 11: Terminal Configuration
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Connector Pin-out

Connector J7 External 5-Pin Connector
1 = Vaux (6 to 13 VDC) = 1
2 = n/a = no connection
3 = Vbat+ (1.8 to 3.3 VDC) = no connection
4 = Ground = 5
5 = Comm D+ = 3
6 = Comm D- = 2

Power Supply
Internal 2 AA Alkaline Batteries
Auxiliary 6 - 13 VDC, 15 mA
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Appendix B: Using USB-to-Serial Cables

The standard communication cable/RS485-232 adapter that comes with the Smart Sensor
plugs into a 9-pin serial port on the PC or laptop. Many new computers, especially
laptops, do not come with 9-pin serial ports. If you have one of these computers, or if all
of your serial ports are in use, you can connect to a Smart Sensor using a USB-to-Serial
adapter, as shown in figure 10.

Figure 10: Connection using a USB to Serial Cable

USB-to-Serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet. INW recommends the Keyspan USB Serial
Adapter from CompUSA. Installation is straightforward - plug into USB port and install
the drivers provided with the particular unit. Most USB-to-Serial cables will work on
Windows 98, ME, 2000, and XP.
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Reordering Information

For sales & service offices, please contact:

Instrumentation Northwest, Inc.
www.inwusa.com

800-776-9355
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LIMITED WARRANTY/DISCLAIMER -
AquiStar® T-16 SMART SENSOR

A. Seller warrants that products manufactured by Seller when properly installed, used
and maintained, shall be free from defects in material and workmanship.  Seller’s
obligation under this warranty shall be limited to replacing or repairing the part or
parts or, at Seller’s option, the products which prove defective in material or workman-
ship within ONE (1) year from the date of delivery, provided that Buyer gives Seller
prompt notice of any defect or failure and satisfactory proof thereof. Any defective part
or parts must be returned to Seller’s factory or to an authorized service center for
inspection. Buyer will prepay all freight charges to return any products to Seller’s
factory, or any other repair facility designated by Seller. Seller will deliver replace-
ments for defective products to Buyer (ground freight prepaid) to the destination
provided in the original order. Products returned to Seller for which Seller provides
replacement under this warranty shall become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive
materials, corrosion due to aggressive fluids, mishandling or misapplication. Seller’s
obligations under this warranty shall not apply to any product which (a) is normally
consumed in operation, or (b) has a normal life inherently shorter than the warranty
period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written
approval by the Seller, all warranties are void. Equipment and accessories not manufac-
tured by the Seller are warranted only to the extent of and by the original manufacturer’s
warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY. IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.
SELLER’S WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER
(EXCEPT AS TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN. IN
NO CASE WILL SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR
PERFORMED IN CONNECTION WITH REMOVAL AND REPLACEMENT OF THE
SENSOR SYSTEM, LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED
BECAUSE OF INTERRUPTION OF SERVICE. A NEW WARRANTY PERIOD SHALL
NOT BE ESTABLISHED FOR REPAIRED OR REPLACED MATERIAL, PRODUCTS OR
SUPPLIES.   SUCH ITEMS SHALL REMAIN UNDER WARRANTY ONLY FOR THE
REMAINDER OF THE WARRANTY PERIOD ON THE ORIGINAL MATERIALS,
PRODUCTS OR SUPPLIES.

B. With respect to products purchased by consumers in the United States for personal
use, the implied warranties including but not limited to the warranties of merchantability
and fitness for a particular purpose, are limited to twelve (12) months from the date of
delivery.

Some states do not allow limitations on the duration of an implied warranty, so the
above limitation may not apply to you. Similarly, some states do not allow the exclusion
or limitation of consequential damages, so the above limitation or exclusion may not
apply to you. This limited warranty gives you specific legal rights; however, you may
also have other rights which may vary from state to state.



8902 122nd Avenue NE
Kirkland, WA 98033 USA 
425-822-4434
FAX 425-822-8384  /  info@inwusa.com

INW

AquiStar® T16/T8
Smart Sensors

(16 or 8 Channel Temperature)

©1997 - 2005 by Instrumentation Northwest, Inc. All rights reserved. Instrumentation Northwest and INW 
are trademarks registered with the U.S. Patent & Trademark Offi ce.  Doc# 9B0815r2 08/2005   /   PN 6D287-NI

INSTRUCTION MANUAL


